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Skill Set 3 
 

Working with E-mail 

By the end of this Skill Set you should be able to: 

Format a Message 
Reply to Messages 
Forward Messages 

Send Messages to Multiple Recipients 
Send Carbon Copies 

Send File Attachments 
Open and Preview Attachments 

Spell Check a Message 
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Exercise 12 - Formatting E-mail Messages 

Knowledge: 

Outlook allows you to apply font formatting to your messages to make them more 
readable and visually appealing (e.g. bold, italic, underline), just as you would use 
Word to create and format a word processed document. 

Activity: 

1. Open Outlook and start a new message (maximise the window). 

2. Enter the following e-mail address into the To box: 

demo@bigplanetsupport.co.uk 

Note: The e-mail address provided above has been created specifically to 
accompany this guide. You can use it to practise sending e-mail messages 
to others. The first message you send may receive an automatic reply, but 
all others will go unanswered and will be deleted automatically. If you 
experience any problems with this address, please substitute it for another of 
your choice (e.g. a willing friend’s). 

3. Enter the subject Office Party. 

4. Click once in the Message Area and enter the following text: 

Our office party will be held a week next Friday at Frank’s 
Seafood Bar & Grill on the Waterfront. 

5. Notice the panel of buttons that appear across the top of the new message 
window. As with the main Outlook screen, this area is called the Ribbon, and 
consists of a range of tabs containing related buttons within groups. 

 

Note: The File tab contains a list of basic program functions such as Save, Save 
As, Print and Close. More advanced options can also be found here. 

Ribbon 

File 
tab 

Message 
Area 
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Exercise 12 - Continued 

6. The buttons on the Ribbon are used to select an action or command in 
Outlook. Move your mouse pointer over any button but do not click (e.g. the 
Bold button in the Basic Text group on the Message tab). Read the ToolTip 
that appears which gives the name of that button and a small description. 

 

Note: If buttons in the Basic Text group are not available, make sure HTML is 
selected in the Format group on the Format Text tab. 

7. In the Message Area, click and drag the mouse over Frank’s Seafood Bar & 
Grill to select and highlight it. 

8. Ensure the Message tab is displayed on the Ribbon, and then click the Bold 

button, , in the Basic Text group. The text is made bold. 

 

9. Add the following text to the end of the message: 

The meal will be followed by live music from Steven Seagull 
and the Bandits. 

10. Select the text Steven Seagull and the Bandits. 

11. To make this text Italic, click . 

12. Start a new paragraph and add the following text to the message: 

Please let me know if you will be attending. 

13. Click and drag the mouse over the whole new sentence, highlighting it. 

14. To underline this text, click . 

 

15. Leave the e-mail message open for the next exercise. 
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Exercise 13 - Advanced Formatting Options 

Knowledge: 

Similar to a word processing program, Outlook also allows you to format font type, 
text size, text alignment, and indentation. You can even add bullets and numbering. 

Activity: 

1. The Office Party e-mail message should be open from the previous exercise. 

2. Create a blank line and add the following text to the bottom of the message 
(make sure no formatting, such as underline, is currently applied): 

 Starters 
 Blue Shark Soup 
 Curried Shrimp 
 Prawn Cocktail 

3. Create a blank line and add the following text: 

 Main Course 
 Lobster 
 Sea Bass Surprise 
 Trout and Chips 

4. Highlight the word Starters. Click  to make the text bold, and click  to 
underline it. 

5. Make the text Main Course bold and underlined also. 

6. Highlight the individual courses and use  to make them italic. 

7. Highlight all of the text from the word Starters to the end of the message. 

8. Click  to Center the menu. 

Note: The alignment buttons next to the Center button can be used to left align or 
right align the text. 

9. Click the drop-down arrow on the Font Color button. Select a shade of blue 
to change the colour of the menu text. 
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Exercise 13 - Continued 

10. Click and drag to select all of the text in the Message Area (or use the 
keyboard shortcut <Ctrl A>). 

11. Locate and click the Font drop-down arrow (the small downwards pointing 
arrow found to the right of the Font box), and then select Tahoma from the 
options that appear (you may need to scroll down a little). 

 

12. Select 12 from the Font Size drop-down list to increase the size of the text. 

13. Select the list of three starters and click Numbering, , to number the list. 
Repeat this action for the three main courses. 

Note: You can also use the Bullets button, , to created a bulleted list, or the 

Indent buttons, , to increase or decrease the left margin. 

 

14. You have finished creating the e-mail message. Click the Send button to send 
it (remember to use the Send/Receive All Folders button if necessary). 

Note: If you receive a prompt to correct spelling errors in your message, click 
Cancel. Checking e-mail for spelling errors is covered in a later exercise. 
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Exercise 14 - Multiple Recipients 

Knowledge: 

You can easily send any e-mail message that you create to more than one person, 
so that you can communicate with multiple recipients at the same time. Simply enter 
each person’s address in the To box. 

If you would like others to receive a copy of a message for information purposes 
only, their e-mail addresses can be entered in the Cc box (which stands for Carbon 
copy). Typically, recipients of carbon copies are not regarded as participants in a 
conversation, but as observers. For example, if you send an e-mail to a customer, 
you could also send a carbon copy to your manager for information purposes. 

Activity: 

1. Start a new message. 

2. Enter your own e-mail address in the To box. 

Note: It may seem strange addressing messages to yourself, but this simple 
technique allows you to observe the results of sending e-mail. 

3. After your own e-mail address, press the semicolon key <;> (if one does not 
appear automatically) and then type the address of a second recipient: 

julie@bigplanetsupport.co.uk 

Note: The semicolon character ; is used to separate multiple e-mail addresses. 
When you click away from the To or Cc boxes, Outlook will automatically 
underline each address to show they are valid. 

 

4. You’d like to send a copy of this message to your manager, Atesh. In the Cc 
box, enter his e-mail address: 

atesh@bigplanetsupport.co.uk 

Note: The e-mail addresses provided here have been created specifically to 
accompany this guide. They will not be received by a real person, and you 
will not be sent a reply. If you experience any problems with these 
addresses, please substitute them for others of your choice. 
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Exercise 14 - Continued 

5. Enter the subject: Tomorrow’s Meeting. 

6. In the Message Area, type the following text: 

Don’t forget the meeting with the area manager at 2pm tomorrow. 

 

7. Send the message. 

8. Return to your Inbox folder. After a moment, you will receive the e-mail that 
you addressed to yourself (remember to use the Send/Receive All Folders 
button if necessary to check for new messages). 

Note: The recipients Julie and Atesh (as well as you) will all receive the e-mail, 
but you will not receive confirmation of this. 

9. Select the e-mail in the Message List to preview it in the Reading Pane. 

 

Note: Notice that you can see the e-mail addresses of everyone that the message 
was addressed to. Each recipient can also see this list, which you need to 
consider when sending messages to others. 

 

Note: Although outside the scope of this guide, it is also possible to send copies of 
a message to others without all recipients knowing about it. This is known as 
a Blind carbon copy and is covered in more depth at level 2. 

10. Leave your Inbox open for the next exercise. 
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Exercise 15 - Replying and Forwarding 

Knowledge: 

When you receive an e-mail message, it is very easy to create and send a reply to 
its sender. A message window will appear where your reply can be entered (the 
original message will be included underneath for reference). A message can also 
be forwarded to someone who wasn’t on the original list of recipients. 

Activity: 

1. Within your Inbox folder, select the Tomorrow’s Meeting e-mail message on 
the Message List (if it is not already selected). 

2. On the Ribbon, click the Reply button in the Respond group. A 
message window, addressed to the sender of the original message 
(you), will appear. 

Note: The text of the original message is also displayed in the Message Area. 

 

Note: The Reply button is used to reply to the original sender. The Reply to All 
button, however, can be used to reply to the original sender and all of the 
message’s recipients. 

 

Note: The Subject begins with RE: indicating a reply to a previous message. 

3. Enter the following text in the Message Area (above the original message): 

Thank you for your message. I have made a note of the details. 
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Exercise 15 - Continued 

 

4. Send the message. 

5. After a moment you will receive the e-mail reply (which was again addressed 
to yourself – remember to use the Send/Receive All Folders button if 
necessary to check for new messages). 

6. Select the reply in the Message List to preview it. 

7. You would like to send this message on to another person. Click the 
Forward button on the Ribbon. A new message window will appear. 

Note: Notice that the Subject section begins with FW: indicating a forwarded 
e-mail. An additional message can be typed in the main window, leaving the 
original e-mail text underneath for reference. 

8. Enter the e-mail address robert@bigplanetsupport.co.uk in the To box. 

9. In the message area, enter the following text (above the original message): 

We’re having a meeting tomorrow afternoon. Feel free to come. 

 

10. Click Send. The message has been forwarded. 
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Exercise 16 - E-mail Attachments 

Knowledge: 

It is possible to attach files to an e-mail message in Outlook. The attached files are 
then transmitted along with the message and can be saved or opened by the 
person who receives it. This makes it easy to send reports, charts, sound files or 
pictures anywhere in the world. When the message reaches its destination, a 
paperclip icon, , will let the recipient know there is an attachment. 

Activity: 

1. Start a new message and address it to yourself. 

2. Enter the subject as Candidate and, in the Message Area, enter the following 
text: 

I’ve had another application for the post of Head Chef. His CV 
and photograph are attached. 

3. Maximize the message window and click the Attach File button in 
the Include group on the Ribbon. The Insert File dialog box 
appears. 

4. Select the location where the data files for this unit are stored (see note on 
page 3), and then click CV once to select it. 

5. Click the Insert button, and the document file is attached to the e-mail. The 
attachment appears in a new Attached box under the Subject. 

 

Note: Depending on your default settings, attachments may appear as icons in the 
Message Area instead. 

 

Note: You can add more than one attachment to a message. 

6. To add a second attachment, click the Attach File button again. This time, 
attach the image file James. 

 

7. Send the message. 
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Exercise 17 - Receiving Attachments 

Knowledge: 

When you receive an e-mail containing attachments, it will appear in the Message 
List marked with a paperclip icon, . The attachments may then be opened and/or 
saved to your computer for later use outside of Outlook. 

Activity: 

1. The Candidate message sent to your own e-mail address in the previous 
exercise should now appear in your Inbox folder (remember to use the 
Send/Receive All Folders button if necessary to check for new messages). 

 

2. Notice the paperclip icon on the Message List – this indicates that the e-mail 
has attachments. 

3. Select the message to preview it in the Reading Pane. The attached files 
appear as icons on the message.  

 

4. Click the CV icon once. A warning about previewing files may appear. 

 

Note: Because of the danger of viruses in e-mail attachments, you should only 
open or preview messages from trustworthy sources. Even then, it is 
recommended that you save the file to your computer and scan it with your 
antivirus software first. 

Attachment 
icon 
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Exercise 17 - Continued 

5. If a warning appears, click the Preview file button. The document opens in 
the Reading Pane. 

 

Note: Notice the new Attachments tab that has appeared on the Ribbon. 

6. Click the attachment James to preview the image file. 

7. To save both of these files to your computer (outside of your Outlook 
mailbox), click Save All Attachments on the Ribbon. 

Note: You can save a single attachment individually using the Save As button. 

8. The Save All Attachments dialog box appears. 

 

9. With both attachments selected in the Attachments box (which they should 
be by default), click OK. An Explorer window appears prompting you to select 
a location to save the attached files to. 

10. Ensure that the save location is your Documents folder/library (but not the 
Data Files folder). 

11. Click OK to save the attached files. 

12. Open your Documents folder from the Start menu to see the saved files.  

Note: You can now check the files for viruses or open them in their default program 
(e.g. Microsoft Word or Microsoft Photo Viewer). Try it! 

13. Close the Documents Explorer window. 
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Exercise 18 - Spell Checking 

Knowledge: 

Outlook contains a spell-checking feature which can be used to check the spelling 
of messages before they are sent. This is a very useful feature and ensures that 
your e-mails always appear professional. The spell checker is very similar to the 
one available in Microsoft Word. 

Activity: 

1. From the Home tab, create a new message addressed to you, containing 
intentional spelling mistakes (you can copy the example text below). 

 

Note: Spelling mistakes may appear underlined in red as you type them (as seen 
in the picture above). Some simple spelling mistakes may also be corrected 
automatically as you type. 

2. On the Ribbon, click the Spelling & Grammar button in the Proofing 
group of the Review tab. The Spelling dialog box appears. 
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Exercise 18 - Continued 
3. The first misspelled word is highlighted. In our example, this is the word 

“Misteaks”, found in the subject box. Notice the suggested spellings provided. 

4. There are options to leave the word as it is (Ignore Once/All) or Change it. 
Select the correct choice from the Suggestions list and click Change. 

5. The word is changed in the message and the spell checker moves on to the 
next unrecognised word. Continue to correct the remaining errors as they are 
found, either by changing or ignoring them. 

Note: The spell checker will also find duplicated words – if any are found, click the 
Delete button in the dialog box to remove one of the duplications. 

6. Click OK when the message appears to say the check is complete. 

Note:  In general, the spell checker only highlights as spelling mistakes words that 
are not in its dictionary. For example, the words weak and allot are both 
incorrect in our example, but because they are valid words, they may not be 
marked as spelling mistakes (but may be detected as grammar errors). 

 

Note:  It is good practice to always proofread e-mails before you send them. 

7. Close the e-mail message window without saving or keeping a draft (a saved, 
unsent message), but leave Outlook open for the next exercise. 
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Exercise 19 - Develop Your Skills 
You will find a Develop Your Skills exercise at the end of each Skill Set. Work through 
it to ensure you’ve understood the previous exercises. 

1. Create a new, self-addressed e-mail message. 

2. Make sure a Carbon copy will go to: julie@bigplanetsupport.co.uk 

3. Enter the subject Car Service 

4. Enter the following text in the Message Area: 

Remember to book the company car in for a service before 
the end of this month. 

5. Make the text bold, centred and red. 

6. Change the message font to Times New Roman, size 20. 

7. You’ve received a voucher for a reduction from a local garage. Attach the file 
Voucher from the data files 

 

8. Spell-check the message. 

9. Send the message, and wait for your copy to return (don’t forget to use the 
Send/Receive All Folders button to check for new messages). 

10. Preview the Car Service message in the Reading Pane. 

11. Save the Voucher attachment to your Documents folder using the same file 
name (not the data files folder). 

12. Forward a copy of the Car Service message to Robert (include a message): 

robert@bigplanetsupport.co.uk 

13. Reply to all recipients of the Car Service message (hint: use the Reply to 
All button instead of the Reply button). Include the additional text: 

Will do - thanks for the reminder! 

14. Close any open messages and leave Outlook open for the next Skill Set. 
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Summary: Working with E-mail 
In this Skill Set you have seen how to format new e-mail messages, how to send 
messages to multiple recipients, and how to reply to messages and forward them on to 
others. You have also learned how to send, receive, open and save e-mail 
attachments. 

Your OCR ITQ evidence must demonstrate your ability to: 

• Use software tools and techniques to compose e-mail messages: 

 Format text (font, size and colour) 

 Format paragraphs (alignment, bullets, numbered lists) 

 Spell check a message 

• Send e-mail messages: 

 Send a message to multiple recipients 

 Send carbon copies of messages 

• Receive e-mail messages: 

 Respond to e-mail 

 Reply to received messages (to one or all recipients) 

 Forward received messages 

 Send attachments 

 Open and view attachments 


